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Configuration Management (CM)

As of Version 1700, HiICAD enables a central configuration management via the Configuration Editor. This tool
allows the creation of customer-specific configurations for a wide range of tasks, such as dimensioning, annota-
tion, workshop drawing creation, fitting of vertical ladders etc. Once adjusted to company-specific requirements,
these configurations can directly be used in HICAD, without having to specify any further settings.

The goal of our further developments is a gradual transfer of the previously used system files (*.DAT) with their
adjustable parameter settings into the Configuration Editor, thus enabling a central and safe configuration man-
agement.

You can find an overview of the already transferred DAT files in the topic Transfer of DAT Files to the Configuration
Editor orin the PDF file Key names.pdf.

If the PDF file will not be displayed in the Internet Explorer, use a different browser , or right-click on the link and
select Save target as.

Various information contained in the Online Help of the Configuration Management can also be found in the PDF
file ISD-Configuration. pdf.
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Range of features

Hierarchical management of configuration data in the form of module properties

Settings are assigned to modules and sub-modules in a tree-like structure, and represent properties defining the
Behaviour of a module. The categorization facilitates the retrieval of individual settings.

Central data storage

The configuration data are centrally stored in a database file in a defined location within the user system, which
enables an easy backing up, restoring or copying of data.

User-specific data storage

The property definitions are stored separately from the actual user settings. This allows a working in multi-user
environments while eliminating the risk that a user accidentally manipulates the configuration of other users.

Derived configurations

Configuration Management allows, in addition to the basic configuration supplied by the ISD, the utilisation of
further, derived configurations for a definition of company- and/or team-specific settings. Furthermore, you
have the option to offer to users alternative configurations within one derivation level.

Central administration of settings via one common graphical Configuration Editor

The need for time-consuming and error-prone manipulations in configuration files is eliminated. The integrated
validation of setting values by ranges and selection lists minimizes the risk of incorrect configurations and sys-
tem crashes due to invalid values.

Documentation of settings

Each setting has a multi-language short description and comments on the meaning of the setting values. The
Configuration Editor offers a full text search for property names, descriptions and comments.

Update-ability of the database

The data storage in the form of user profiles enables an updating of underlying pre-settings, without having to
change existing user settings. Values that have not been changed by the user will automatically be assigned the
updated pre-settings.

] Please note that the scope of functions available to you depends on the configuration level of your product,

i.e. not all the functions described in the Help may be available in your product!

The range of selectable modules for a local license depend on the license that was purchased.
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Transfer of DAT Files to the Configuration Editor (CM)

As of Version 1700, HiCAD enables a central configuration management via the Configuration Editor. This tool
allows the creation of customer-specific configurations for a wide range of tasks, such as dimensioning, annota-
tion, workshop drawing creation, fitting of vertical ladders etc. Once adjusted to company-specific requirements,
these configurations can directly be used in HICAD, without having to specify any further settings.

The goal of our further developments is a gradual transfer of the previously used system files with their adjustable
parameter settings into the Configuration Editor, thus enabling a central and safe configuration management.

This transfer has already been realised for the following files:
= ALGPAR.DAT (as of 1800.0)
m BEMPAR.DAT (as of 1800.0)
m DIMENSIONING_SETTINGS.XML (as of 1800.0)
m STBEMPAR.DAT (as of 1801.0)
m KRPGEN.DAT (as of 1801.0)
»  MASPAR.DAT (as of 1801.1)
m FITTABLE_SETTINGS.XML (as of 1801.0)
m TXTANSI.DAT (as of 1801.1)
m STABMPAR.DAT (as of 1802.0)
m AUBM3PAR.DAT (as of 1802.0)
m ALG3DPAR.DAT (as of 1901.0)
m SCHRIF.DAT (as of 1901.0)
s TXTFONT.DAT (as of 1901.0)
s FEATURE.DAT (as of 1901.0)
m LINPAR.DAT (as of 1901.0)
m SSWRITESTEP.DAT (as of 1901.0)
= NORM.DAT (as of 2000.0)
m PASSTAB.DAT (as of 2000.0)
m PASSTABO.DAT (as of 2000.0)
m  ANSGEN.DAT (as of 2100.0)
m PARAMASS.DAT (as of 2101)
m SSTINI3D.DAT (as of 2102)
m SSTINI.DAT (as of 2102)
m STB_PARAMETER.DAT (as of 2102)

The settings from the files were transferred to the Configuration Editor. The linked lists or the PDF file shows you
where to find the settings from the DAT files in the Configuration Editor (Key names).

Key names.PDF

If the PDF file will not be displayed in the Internet Explorer, use a different browser , or right-click on the link and
select Save target as.

Various information contained in the Online Help of the Configuration Management can also be found in the PDF
file ISD-Configuration. pdf.
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User Interface (CM)

The Configuration Editor enables an editing and managing of configuration. It provides a generic, hierarchical view
of the data and structures contained in the database.

You start the Configuration Editor outside of HICAD, by executing the file ISDCONFIGEDITOR.EXE in the EXE dir-
ectory of HiCAD.

The permissions to change profiles or settings depend on the behaviour of the Editor when it is started:

Users without administrator rights and users with administrator rights who did not select the Run as administrator
option upon start:

m |nthe Editor, settings can be edited in the profile of the user who is currently logged on Windows.
= The switching to a different user is not possible. The selection box is greyed out.

Users with administrator rights who have selected the Run as administrator option (right-click and select from con-
text menu) upon start:

= The administrator profile can be changed in the Editor.

= The switching to other existing profiles is possible via the selection box, which enables a checking and/or chan-
ging of the configurations of various users.

You can also start the Configuration Editor directly from HIiCAD: At the top right corner of the HiICAD window, select
Settings > Configuration.

You require administrator rights to start the Configuration Editor!

I 15D Configuration Editor - HICAD 18.2.0.247 [€:\ProgramData\ISD Software und Systeme\HICAD 2013\HICAD.cfgdb] 9 =10 x|
Fe Edt Ve Exves 1sOffY]
V4 [= g-u e GUSE Administrator @.‘a
B quco Description Value Comment
= %J..Eu\:cmﬁg!amn (Base configuration) T .
=] aning
B [ Annotations 15t dim Other dimensi | Arrowhead, filed =] Type of 15t dimension kne termination for other d
B 2 Automatic annotation Height, 15t dinenson ine termination, Other dmensions L5 Heaght of 1st dimension ine termination, Other dmensions =
2 Prefarred ) — ﬁ‘@ Length of 15t dmension lne termination for other
9 ] Dimensicning, 2-D Length, 15t dmension lne termination, Other 4 gt !
2 ok joning, 30 e | Colour of 1st demension line termination, Other dmensions
:*:DSEI::W ) Colour, 1st dimension line termination, Other dmensions [ -2 (== same as dmensioniine 2T e colour)
¥ O Parametric dmensions 2nd dimension termination, Other I.lrrm\'head.ﬂed LI Type of 2nd dmension line termination for other dimensions
3 HCM dimensions Height, 2nd d ion line i Other L5 Height of 2nd di ion line " Other
I Steel Engineering dmension . Length of 2nd dimension line termination for other
@ (2 Fits table Length, 2nd dn i Other 4 o bl
@ [ Grid annctation P = | Colour of nd di Ine Other d
- '_'alvlol:rt:o Colour, 2nd ne Other | -1: ==7 same as dmension ine | 1 = Dimension e colour)
& [ System tiangle Dimension ine termi Base e dimerisk [ filed =] Type of dmension ine jon for base ine
& [0 Weld seam tags Height, Dimension ine termination, Base ine dimensions L5 Height of dimension line i Base ine
:"-‘ [ Drawing frames Length, Dimension line termination, Base line dmensions. 4 Length of dimension line termination for base line dmensions
B Automatic drawing derivation _— . = Colour of dimension ine termi Baseline d 1
& 3 Modeling Colowr, Dimension line termination, Baseline dmersions [ Same as dmensonine = | 700 STEREE TS
- gstw Dimension lne termination, Heights above datums | Arronhead for Height above datum, Cic ¥ | Type of dmension lne termination for heights above datums
i+ Me! Elig'Eﬁlw
& T Plant # Height, Dimension kne termination, Heights above datum 4 Height of dimension Ine termination, Heights above datum
@ [ Sheet Metal D e tion, Hei datum 4 mﬁmhmmhwum
T Assembling Simulation . - .
- . B Colour of dimension Ine termination, Heights above datum
= Analysis Colour, Dimension kne termination, Heights sbove datum |- == seame asdmensionine = {°1 = Dimenion lrve colour)
# I Interfaces . . I =1 Type of st dimension lne termination for angular
i 1st Anguar [ filied =] ik
® 2] Compatibiity Height, 1st dimension line termination, Angular dimensions. LS Hesght of 1st dimension line termination, Angular dmensions.
i 7 System settings , 15t dmension ine terminati . 4 Length of 1st dmension line termination for angular
% I[f) Confgurations dmensions
= | Colour of 1st dmension ine termination, Angular dmensions
= = - Colour, 15t dimension line termination, Angular dmensions l 1: (=) Same as dmension ine (-1=D ine colour) -
Drawing > Annotations > Dimensioning, 3-0 )Illh:racﬁvt\‘ﬁme

The user interface of the Configuration Editor consists of the following areas:
1. Menu bar

2. Toolbar

3. Search function

4. User selection
5

Current configuration structure tree
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Data record of active configuration
User Management

Path of the currently selected structure item

O o N o>

Version and name of the configuration database

I Important:

Changes in the Configuration Editor will only take effect after you re-start HICAD. Only some particular settings,
such as dimensioning pre-settings, can be applied, via the corresponding HiCAD functions, without a re-start.
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Menu Bar (CM)

The menu bar of the Configuration Editor contains the following menus:
m File
m Edit
n View

m Extras

@ Please note:

Some of the function in the menus will only be active when a data record has been selected in the right pane of the
window.

File (CM)

Export and import of setting values

The structure and the values of the configuration can be written to a XML file with the Export function. The export
function refers to the currently selected item in the configuration tree. The exported settings can then be imported,
forexample, to another configuration database.

Edit (CM)

The configuration database administers values on the basis of user-specific setting profiles.

When you select a data record in the tree structure in the left pane of the dialogue window, the corresponding set-
tings will be displayed in the right pane of the window. You can use the functions of the Edit menu to modify these
values and the tree structure.

The changes will take effect after you re-start HiCAD.

Function Description

Change If youwant to change a value in a data record, activate the desired item and select Change.
Description Value Comment
Distance for outer dimensioning IE— Switch to outer dimensioning if distance is smaller
Excess length for ext. dimensioning 1.5 Dimension line excess length for outer dimensions
Minimum dimensian line length 12 Minimurm length of dimension line
Maximum dimension line length 50 Maximum length of dimension line

You can also activate the value via double-click or by pressing the F2 key, and then overwrite
it.

Changed values, i.e. values deviating from the underlying profile level, are marked appro-
priately and can be reset to the original default value at any time.

Reset This function restores the selected value to the state in the database.

Copy key Use this function to copy the names of the marked key values in the right window, for
example, to a TXT file.

Rename Use this function to rename derived structures and derived configurations in the tree structure.
The derived structure will be identified by the & icon.

Delete This function deletes only derived structures and derived configurations in the left pane of the

L_ [
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Function Description
Configuration Editor.

Derive Use this function to copy the selected branch in the tree structure and paste it with a different
structure name.

Select ref- If a referenced structure has been activated, this function activates the reference.

erence

Activate The 2nd level of the tree structure in the left pane of the Configuration Editor consists of the
con- areas:

figuration

= Active configuration and
m Configurations.

The configuration that you activate with this function will be displayed in the Active con-
figuration area and can then be modified.

Derive con- Use this function to derive an alternative, complete configuration.

figuration Here, too, the same principle as for structure derivation applies: Unchanged settings inherit
their values from the default values (ISD or Administrator profile) of the superordinate con-
figuration.

To edit the derived configuration, select Activate configuration.

Derive Configuration (CM)

Derived configurations have a tree-like structure and function according to the same principle as the overlaying of
values in user profiles, i.e. unchanged settings will inherit their values from the default values (ISD or Administrator
profile) of the superordinate configuration. Configurations on the same derivation level are independent from each
other.

To derive configurations, select Edit > Derive configuration. Derived configurations will be displayed in the left
pane of the window, under HiICAD >Configurations. The derivation will be created from the currently active con-
figuration.

To edit a derived configuration, select Edit > Activate configuration. The derived configuration will then be dis-
played under HiCAD > Active configuration and can be edited.

] Important:

To prevent an accidental overwriting of the base configuration, i.e. the ISD default setting, you should only create
derivations of company-specific configurations. To restore the ISD default settings, the configuration database
(HiCAD.cfgdb) must be re-installed.

Derive Structure (CM)

Referenced and derived structures generate value inheritance lines. This enables you to create tree units (or indi-
vidual settings) that refer to a reference tree unit and obtain unchanged values initially from the default values of
the reference.

Example: Creation of a new drawing frame for workshop drawings

1. Inthe tree structure, select ... > Drawings > Drawing frames > DIN_AQ. Then select Edit > Derive structure.
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i ml
File Edit View Extras ISD
= User  Administrator - |
| =
= -]_'|HiCAD 1= Description Value Comment
El [ Active configuration (Base configuration) Figure name DINAD  must be located as file in HICAD path C:
% Analysis Frame width 1179 Dimensions of usable area
= Assembling Simulation
) g Frame height 831 Dimensions of usable area
= Compatibility
B = rawing Horizontal distance of insertion peint to centre 0
= Annotations Vertical distance of insertion paint to centre 27.63
B = prawing frames X-minimum of locked area 991.8 Title block, tables, comments
—%DIN Al ¥ -minimum of locked area 0 Title block, tables, comments
-%DIN e 8l Il Derive structure X Bbles, comments
C3DIN A3 v . ts
ERDIN AdH " Code |Drawing.DrawingFrames.I]IN_AI} pDIes, commen
3DIN A4Q |
Zomao I werte kopieren | DIN A1 =l
= Automatic drawing derivation
= terfaces _ot | _canel |
= Metal Engineering LI

2. Change the displayed key to Drawings.Drawing frames.DIN_Ab.

The structure DIN_AD that will be created now will initially inherit all values from the reference structure DIN_AO.
This means that if one of the default values of DIN_AO will be changed, this value will also change for DIN_AbS. The
values of DIN_Ab can be assigned new default values. If a default value in the derived structure has been changed,
the value from the reference structure will no longer be inherited, i.e. changes of the corresponding value in the ref-
erence structure will no longer affect the derived value.

Use the Copy values option to take over changed values from a data record that is linked to DIN_AO, e.g. DIN_A3.

L Updates of the reference structure containing new or deleted settings will be adopted by the derived struc-
ture.

View (CM)

Update

If you change the configuration settings in HICAD while the Configuration Editor is open, the new settings will only
be displayed after activating the Update function.

Example:

When saving the rules set, the rules will be transferred to the Configuration Editor. The rules which are stored there
will be adjusted accordingly, new rules are added, or existing rules are deleted if required. After selecting Update,
the changes will become visible in the Configuration Editor.

L Please note that HICAD will apply the changes from the configuration management only after restart.

Display key names

HICAD uses the key name to access the settings of the configuration management. The key name is identical in all
languages.

A description of this name is displayed in the standard view.
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Example

File Process | View Extras ISD
7 o Update F5 )
—————  Display key names —
= [HicAD |a] Description Value
= = Active configuration (Base configuration) T —
S o fault value for colour of
| Assembling Simulation Default value for colour of lines 0
= Compatibility Line type of dimension lines 1
= = Drawing Distance of dimension line 8
= = Annotations Distance of dimension line for parallel dmensions 10
g Automatic annotation Distance for outer dimensioning 8
=1 Di ioning, 2-D
!menm.an!ng; Excess lenagth for ext. dimensioning 1.5
[ Dimensioning, 3D
3 Fits table Minimum dimension line length 12
= Grid annotation Maximum dimension line length 50
[= Plot stamp _ Line type of projection lines 1
(= system triangle Distance 1st projection line 1
(= weld seam tags Distance 2nd dimension line 1
(=] Drawing frames T — . 5
nterruption distance for projection lines
[E automatic drawing derivation P proj
2

& Interfaces

‘ 15D Configuration Editor - HiCAD [C:\ProgramData\IsD Software und Systeme\HiCAD 2013 \HiCAD.cfgdb]

Projection line excess length

File Process View Extras ISD

A
= E
= -.]_'|HiCAD = Mame Value Description
E [El Active configuration (Base configuration) T ——
= analysis
= AssemblySimulation IFARDFLIN 0 Default value for colour of lines
= compatibility ISTRART2DF 1 Line type of dimension lines
= = Drawing ABSTDF 8 Distance of dimension line
= = Annotation DEFABSDF 10 Distance of dimension line for parallel dmensions
g AUTOLABELLING LABWDF 8 Distance for outer dimensioning
=1 Di ioning 20
fmens!on!ng IUBLDF 1.5 Excess length for ext. dimensioning
[= Dimensioning3D
BHOZDF 12 Minimum dimension line length
RAMADF 50 Maximum dimension line length
_ ISTRARTIDF 1 Line type of projection lines
=| SYSTEMTRIANGLE ABM1DF 1 Distance 1st projection line
= WELDFLAG ABMIDF 1 Distance 2nd dimension line
4 DrawingFrames DELTAMHL 5 Inte tion distal fol jection li
P DrawingGeneration nterruption distance for projection lines
= Interfaces 1 LMHLDF 2 Projection line excess length

Extras (CM)

Language

You can currently select between English and German.

Performance - Features - Scenarios
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Database directory

Example
E] ISD Configuration Editor - HICAD [DAL80X\dewInstalh\Configuration\HICAD.cfgdb]
File Process View |Extras | 1SD
Fa Language r German (Germany) L
P .jHiCAD i v English (United States) Value
4 [E] Active config Database directory French (France)
= s , Italian (Italy) :
= Assembling Simulation
= Compatibility Strichart fiir MaBlinien 1
4 [ Drawing Distance of dimension line 8
4 [ Annotations Distance of dimension line for parallel 10
=] Automatic annotation dimensions
Eoosaii Distance for outer dimensioning g8
= Dimensioning, 3-0
= Fits table Excess length for ext. dimensioning 15
A ridl annatatinn
E] ISD Konfigurationseditor - HICAD [DA180X\devinstall\Configuration\HICAD.cfgdb]
Datei Bearbeiten Ansicht | Extras | ISD
Fa) Sprache v | German (Germany) Benut:
4 [qHiCcAD Suchen F3 English (United States) Wert
4[] Aktive Konfiguration Datenbank-Verzeichnis French (France)
d Analyse ——yr Italian (Italy) ‘
= Montagesimulation o
= Kempatibilitat Strichart fiir MaBlinien 1
4 [ Zeichnung Abstand MaBlinie 8
4 [F Beschriftungen o )
73 Automatische Beschriftung Abstand MaBlinien bei Stufenmalen 10
Foooo Distanz fir AuBenbemalung g
=3 BemaBung 30
= Passungstabelle Uberstand bei AuBenbemaBung 15
T Racterhecrhriftunn

Fora HiCAD standard installation the database of the Configuration editor will be stored in the HiICAD installation dir-

ectory, at .. \Configuration\HiCAD.cfgdb.

The location of the database file will be entered into the Windows Registry at
HKEY_LOCAL_MACHINEASOFTWARE\ISD SOFTWARE UND SYSTEME\HICAD\[VERSION NUMBERNHICAD.CFGD

To change the directory for the file, select Extras > Database directory. If you want to copy the database to the
new location, activate the same-named checkbox.

You can also change the path in HiICAD via Settings > Further directories. Before you do so, you need to copy the
database to the new directory.
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i PDM |4~

Configuration

CATEditor
| Settings I

Colour settings .3

<

Activate Start Centre

Activate space mouse

GUI representation

K

Plugins 3
Customize UL

Ribbon categories
Toolbars

%  Docking windows ¥

HIiCAD Settings - Further directorie

Exit  Settings

Line types

@@ Definitions

@ Colour combinations
- @@ Directories

HICAD
=

&

Basic settings

@ Sheet development
@@ Steel Engineering
@ General

10

Directories

Catalogue directory

ConfigDE path

[Logikal

CAHICAD \Kataloge
CAHICAD\Configuration\HICAD.cfgdb
C\Logikal
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Toolbar (CM)

To enable a quick access, some of the functions of the menu bar are also contained in the toolbar:

7 Change If you want to change a value in a data record, activate the desired item and select
Change.
® Reset This function restores the selected value to the state in the database.
o~ Update If you change the configuration settings in HICAD while the Configuration Editor is open,
the new settings will only be displayed after activating the Update function.
';:E? Collapse @ This function collapses the structure display of the Configuration Editor and shows only
all the 1st level.
= Expand Shows you the first 2 levels of the configuration structure.
2 levels
=3 Expand Shows you the first 3 levels of the configuration structure.
3 levels
'J:,'E Expand Expands the complete structure display of the Configuration Editor.
all
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Search Function (CM)

The Configuration Editor offers a full text search for value descriptions, comments and setting names. During the
process, the Editor browses through the structure, beginning (or continuing) at the currently selected node of the
configuration tree. Enter the desired search term and click the Find icon.

Frame width | 4

Search for data records

To perform a targeted search for particular entries (e.g. font or font size) in other data records, right-click the
desired data record and select Search value.

I 15D Configuration Editor - HICAD 18.2.0.247 [C:\HiCAD\Configuration\HiCAD.cfgdb] =8|
File Edit WView Extras ISD
V4 (] @ User Administrator - |
= -.h HICAD - Description Value Comment
Bl 5 Active configuration (Base configuration] Font (T | Font (Mame of operating system font or HICAD font number with
= = Drawing Change hation)
= & Annotations # Colour - Folour
Reset
Automatic annotation . X
Dimensioning, 2-D size =
d Search value )
= = pimensioning, 30 Angle otation angle
2 bt i . aspect ration and indination)
b el Font By fied in SCHRIF.DAT
= = Parametric dimensions — - r HICAD fonts
= Font: Dimension figu width S2EE SRR eight
[= Font: Symbols Derive structure for operating system fonts
[E Font: Auxiliary text
Select reference
|Z Font: Tolerances e
[E HCM dimensions Edit texts
1 Steel Engineering dimens| =
Fits table Permissions
= Grid annotation

In the search mask you can limit the search to a particular area of the configuration structure tree, by activating the
Limit to checkbox and selecting the area of the configuration structure from the drop down menu.

Find £
Description:  Font

Value:

Limitto  |Dimensioning, 3-0 -

Find

When you click the Find button, HiICAD will jump to the next data record that meets the specified search criteria.
You can change this data record if desired, and continue your search.
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User (CM)

The configuration database manages values on the basis of user-specific setting profiles. Two pre-defined profiles,
namely ISD and Administrator, have a special function.

User [Administrator |v %

ISD
Administrator
Buildsystem

Valu

The ISD profile forms the basis for the settings. In this profile, the HiICAD settings preset by the ISD are contained.

The Administrator profile allows the creation of company-wide default settings deviating from the ISD defaults. In
the process, the Administrator profile constitutes a level overlaying the ISD profile: Unchanged values will be read
from the ISD profile, so that changes of the ISD settings will automatically be transferred to the Administrator profile
(and thus also to the superordinate user profiles) when being updated. Modified, company-specific values will how-
ever be retained.

Profiles of other users overlay the Administrator profile according to the same principle, with each user profile being
independent of the other user profiles. If setting values are written from HICAD into the database, this process will
always be performed via the profile of the user name currently logged on to Windows. In this way, an accidental
changing of user settings, company-wide settings, or ISD default settings by other users via HiCAD will be pre-
vented.

The permissions to change profiles or settings depend on the behaviour of the Editor when it is started:

m Users without administrator rights and users with administrator rights who did not select the Run as admin-
istrator option upon start:
« Inthe Editor, settings can be edited in the profile of the user who is currently logged on Windows.
o The switching to a different user is not possible. The selection box is greyed out.
m  Users with administrator rights who have selected the Run as administrator option (right-click and select from
context menu) upon start:
« The administrator profile can be changed in the Editor.
« The switching to other existing profiles is possible via the selection box, which enables a checking and/or
changing of the configurations of various users.

To edit an entry, double-click a cell in the Value column, or select a cell and press the F2 key, or click the Change
icon on the Toolbar.

Changed values, i.e. values deviating from the underlying profile level, are marked appropriately can be reset to the
original default value at any time.
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User Management (CM)
The integrated User Management allows the creation and deletion of user profiles, as well as the deletion or the tak-
ing over of user-specific values into other user profiles. In this way, for example, an Administrator is enabled to spe-
cify settings via HICAD managed in the Configuration Editor. These are initially saved in his/her Windows user
profile, and can later be taken over to the administrator profile as company defaults, and will then apply to all users.
Click the e icon to call the User Management. The dialogue window is composed of the following tabs:

m Settings

m User

n Groups

Click the E icon to close the dialogue window.

! " Important:

The permissions to change profiles or settings depend on the behaviour of the Editor when it is started.

Settings

x

Settings | User | Groups

Same configuration for all users

If you use a central configuration database the the settings saved in the configuration database will
have effect on all HICAD users. The last saved settings apply to all users.

A change of this setting requires a re-start of all applications using the configuration database.

[Apply and restart Editor

Activate the Same configuration for all users checkbox to switch off the User Management and the Permissions
Management. The settings will then always be written to the Administrator profile.

The User Management is by default deactivated when the configuration database is installed for the first time.
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User Interface (CM)

User
‘ User Management El
| Settings | User | Groups |
Mame I Active configuration | Group assignment | I [ Add ]
Administrator [Same as main group T] Administrators
User 008 [Sameas main grnupv] Designers A, Designers B [ Rename ]
User 023 Same as main group > [ DesignersB
[ d Dj - [ Delete ]
[ Group assignment ]
=Groupassignmentfur Users: User 023 il
Everyone
| Administrators
|| Designers &
Diesigners B
[ Ok ] [ Adopt values ]
[ Cancel ] [ Delete values ]
User tab
Add Adds a new User to the table.
Rename Enables you to change a selected User name.
Delete Deletes the selected User without any further confirmation prompt.
Group The user rights are controlled via group assignments. A User can belong to several Groups.
assign- Use the Group assignment button to select Groups for Users. The main Group of the User will
ment be highlighted if you mark this Group and then click the As default button. The main Group will
be available during the configuration selection of the User. Click OK to exit the Group selec-
tion.
Adopt val- Use this function to apply the values of a selected User to the active User.
ues ('R 1SD Konfigurationseditor - HICAD [DAL80X\deviinstall\Configuration\HICAD.cfgdb] b= [ |
Datei Bearbeiten Ansicht Extras  ISD
e 2 Benutzer Administrator - %_.
4 -hHiCAD Beschreibung Wert Kommentar
« 4 )I\;t::::::guratlon (Konstrukteure E] BemaBung der 5zene beim Laden konvertieren? J;\Zliii?(;iir:;?;gﬁ?bam .
[E Montagesimulation BemaBung von freigegebenen Zeichnungen beim :::fgr[:i-B:r:liE:;f ;:;r;rl;aden
4 [ Kompatibilitat Laden konvertieren? konvertigergn?
4 = Beschriftungen E
MNach dem Konvertieren Meldung ausgeben? [} g:;::jnmg::x::?s;egn:iegriz;
Delete val- Deletes the changed values of the selected User, thus restoring the values to that of the admin-
ues istrator profile / the values preset by the ISD.
Table The Configuration Editor allows the creation of different user configurations via the Derive con-
column: figuration function. One of these configurations and the Base configuration can be assigned to
Active con- | the User in the Active configuration column.
figuration
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g’ Please note:

HICAD will use the Windows Login name in case of an utilisation via HiCAD, i.e. these names need to match when
users are created.

Groups
x|
Settings Groups
Mame | Active configuration | | [ Add ]
Everyone [Ease configuration v]
Administrators [Ease configuration v] [ Rename ]
Designers A [Base configuration v] [ Delete ]
Designers B [Ease configuration 'r]
Permissions for: Designers A
¥| Change property value
| Activate configuration
| Derive configuration
| Rename configuration
|| Delete configuration
|| Derive structure
|| Delete derived structure
|| Rename derived structure
| Change derived texts
| Change permissions
Group tab
Add Adds a new Group to the table.
Rename Enables you to change a selected Group name.
Delete Deletes the selected Group without any further confirmation prompt.
Table The Configuration Editor allows the creation of different user configurations via the Derive
column: Act- configuration function. One of these configurations and the Base configuration can be
ive con- assigned to the Group in the Active configuration column.
figuration
Permissions The rights of a Group can be specified in the Permissions for: ... area, by activating the cor-
for:e.g. responding checkboxes. If a User belongs to several Groups, the activated rights of these
Designers A additional Groups are also available to him/her.

The permissions enable you to specify, for example, that a User can only read the settings
defined by the administrator, but not define and save his/her own settings, thus ensuring com-
pany-wide, identical settings.

@ Please note:

= The permissions that are assigned here apply globally, i.e. for all Users of the Group.

= Use the Permissions function if you want to assign permissions for sub-trees of the configuration. You can then
define permissions for Users and Groups .

Performance - Features - Scenarios 21/48



L
H m User Interface (CM)

Configuration Structure (CM)
The left pane of the Configuration Editor dialogue window contains the following entries (below HiCAD):
= Active Configuration and

m Configurations.

‘ 15D Configuration Editor - HiCAD [C:\ProgramData\ISD

File Edit View Extras ISD

l
B

= [HicaD Descr
= [ Active configuration (Baze configuration)
= Analysis
= Assembling Simulation
= Compatibility
| Drawing
= Automatic drawing derivation
& Interfaces
= Metal Engineering
= Drawing
= DM
= Plant Engineering
= steel Engineering
j System settings
= 2 configurations
= [ Base configuration
[ Dezigners &

HEHEHEBKRKGBEE

B Designers B

Under Active configuration you will find the current HiCAD settings.

Under Configurations you can find the base configuration and all derived configurations of the active user. Use the
Derive configuration function to load data into the Active configuration area. There, you can activate individual
data records and edit them in the right pane of the dialogue window.

L Important:

To prevent an accidental overwriting of the base configuration, i.e. the ISD default setting, you should only create
derivations of company-specific configurations. To restore the ISD default settings, the configuration database
(HiCAD.cfgdb) must be re-installed.
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HICAD

Data Record (CM)

In the right pane of the Configurator Editor you can edit the data records that you activate in the left pane of the win-
dow. The data record consists of the Description, the Value and the Comment. When you display the key name via
View > Display key names, the system name of the entry will be additionally displayed.

You define your individual profile for HICAD via the setting of values. The values are not always numerical values.
They may also be:

m a unit of measurement (mm, cm, ...)

a string ("Collection")
a key name

a free entry

a checkmark (e.g. to activate the display of a query etc.)

a procedure (Always, Dependent on dimension plane, etc.)

an entry from the Catalogue Editor

a selection of attributes.

Changed values, i.e. values deviating from the underlying profile level, are marked appropriately and can be reset to
the original default value (right-click and select Reset) at any time.

Some data records can be expanded by new data record entries.

! Important:

m Changes made in the Configuration Editor will only take effect after restarting HiCAD.

m To prevent an accidental overwriting of the base configuration, i.e. the ISD default setting, you should only cre-
ate derivations of company-specific configurations. To restore the ISD default settings, the configuration data-
base (HICAD.cfgdb) must be re-installed.

Change a value in an input field

P -
3 15D Cenfiguration Editor - HICAD 19.2.0.395 [C:\ProgramData\[SD Software und Systeme\HiCAD 2014\HiCAD.dg¢m
- AR S

File Edit View Extras ISD

— e

rd Q @ User |Administrator ?3
4 hH\CAD l Description Value Comment
4 = Active configuration (Base configuration) Uimension text
4 [ Drawing Text height, Dimension text 35 Text height of dimensioning texts
4 [ Annctations 3 3
& ] ) Font for dimension text 1 For HiCAD fonts: 1,2,3,... For TrueType fonts: T1, T2,
[F Automatic annotation T3,
= Dimensioning, 2-D Position (right}, 1st of 2 dimension texts 5 e e e e
= . imension figure, parallel to dimension figure
= Dimensioning, 3-D Pasition of 2nd of 2 d teds relative t
- . osition of 2nd of 2 dimension texts relative to
[ Fits table Position (right), 2nd of 2 dimension texts 5 dimension figure, parallel to dimension Ine
(& Grid annotation Position of dimension text relative to dimension T
= Plot stamp A Position (right], 1 dimension text 0 figure, parallel to dimension line =
= System triangle Pasition (superscript], for one dimensian tect 0 Position of dimension text relative to dimension
=] Weld seam tags figure, vertical to dimension line | 5}
= Drawing frames Dimension figure
é.:/lutgnl:.atlc drawing derivation Position of dimension figure (right) 05 :?::ltégr;flz::‘w:‘%slun figure parallel to dimension
3 Modelling ==
= Steel Engineering Pasition of dimension figure (superscript] 1 E:thmn of dimension figure vertical te dimension
(=] Metal Engineering
! Pasition of dimension figure parallel to dimension
i Plant Engineering Position of dimension figure (right), Base line dimensions 1 line, for base line dimensions
[ Sheet Metal Pasition of dimensian figure (superscript), Base line 1 Pasition of dimension figure vertical to dimensian
[ Assembling simulation [~ | dimensions ling, for base line dimensions
& Analysis Pasition of dimensian figure (right), Heights above datums |5 F”S'tf'””h”f. d;""e"g'”" 29“'5 parallel to dimension
7 Interfaces ing, for heights abowve datum
= POM - Position of dimension figure (superscript), Heights above 15 Position of dimension figure vertical to dimension -

Drawing > Annotations > Dimensioning, 2-D

o)

If you want to change the value of a data record, right-click the corresponding row and select Change. You can also
double-click the row, or press F2, and then overwrite the value.
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Select a value from a listhox
GRS

File Edit View Extras ISD

Vs =) @ User |Administrator m
4 [qHiCAD 1= Description Value Comment
4 [ Active configuration (Base configuration) Factor for 2nd dimension figure, Angular dimensions 11111 Factor for 2nd dimension figure, Angular dimensions
. ﬁ' Set diameter symbol? (Options: iAlways, Mever, Not if
Annotations SEGETEEEmE Abays Nim nlane=Cirle nlans)
Dimensioning, 2-0 Tolerance/Fit
Elmen:llomng_Z—D Default value for colour of tolerances MNever
its table
For HICAD fonts: 1,2,3,... For TrueType fonts: T1, T.
Grid annotation Font for tolerances 1 T;r..‘ ! onts: 1,23,... For TrueType fonts: T, T2,
Plot stamp L # Text height, Tolerance 35 Text height of tolerances
System triangle 1 it -
Position (right], tolerance 1 Position of t.olarances .ra\atwa to dimension figure,
‘Weld seam tags parallel to dimension line
Drawing frames Position (superscript), 1 tolerance 2 Position of tolerance
E Autom.at\.: drawing derivation Position (superscript], 1 tolerance, bottom 3 Position of tolerance, bottom, vertical to dimension
Modelling line
Steel Engineering Position (superscript], 1 tolerance, top 2 Position of tolerance, top, vertical to dimension line
Metal Engineering Position (superscript], 1st of 2 tolerances o ﬁ::ltloﬂ of 1st of 2 tolerances, vertical to dimension
Plant Engineering - : .
Sheet Metal Position (superscript], 2nd of 2 tolerances 3 ﬁ::ltloﬂ of 2nd of 2 tolerances, vertical to dimension
Assembling simulation Tolerance grade 0 Tolerance type (0-8)
Analysis Tolerance value 1 01 Tolerance value 1
Interfaces Tolerance value 2 0.05 Tolerance value 2
PDM b e — -

Drawing > Annotations > Dimensioning, 2-D

Some settings are selected from a listbox.

Take value from catalogue
[ 215D Configuration Editor

File Edit View Edras ISD
PR~ @ User [Administrator (]

4 \hHI(AD Description Value Comment
4 [ Active configuration {Base configuration)

Catalogue assignment: Foil, Available on site Foil, Available on site Selection from catalogue

Drawing

Automatic drawing derivation

Catalogue assignment: Foil, Own production Foil, Own production Selection from catalogue

Medelling

Steel Engineering

Metal Engineering @
I :I'
-4 User material Bz -

= 0 Civil Engineering P Sealing cord, Available on site
Plant Engineering ge=] Civil Engineering materials P Sealing cord, Own production
Sheet Metal b Sealing tapes

P} Sealing compound
P Foil, Available on site
P Foi, Own production

Assembling simulation

= Analysis

Interfaces

P Filing material
FDRA o b Glass =
Compatibility P Solid wood

System settings B Derived timber products

P Insulation, Available on site
¥ Insulation hard

P Insulation soft

P Isolator

P Kies

b Rubber sealing profile

b Light metal

onfigurations

Metal Engineering > Foil > Material

Click the symbol to select a value from the Catalogue Editor. Click the symbol to delete the setting again.
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Select a value by activating/deactivating of a checkbox

File Edit View Extras ISD

Vs e @ User |Administrator B
4 \.hchAD il Description Value Comment
4G Text height of Znd dimensioning symbol 35 Text height of 2nd dimensioning symbol

Annctations

Automatic annotation
Dimensioning, 2-0
Dimensioning, 3-0
Fits table

Grid annotation

Plot stamp

System triangle

‘Weld seam tags

Drawing frames

= Automatic drawing derivation
Modelling

Steel Engineering
Metal Engineering
Plant Engineering
Sheet Metal
Assembling simulation
Analysis

Interfaces

PDM

I

Position (right), 1st dimensiening symbel
Position (superscript), 1st dimensioning symbol
Position (right), 2nd dimensicning symbeol
Position (superscript), 2nd dimensicning symbeol
1st symbol combination

2nd symbol combination

Set symbol for arc dimension

Others
Reference system for circle dimensiening

Circle dimension

Dimension orientation

Pasition of angular dimension

Z-dimensicning for correction

Position of 1st dimensioning symbol relative to
dimension figure, parallel to dimension line

Position of 1st dimensioning symbol relative to
dimension figure, vertical to dimension line

Position of 2nd dimensioning symbol relative to
dimension figure, parallel to dimension line

Position of 2nd dimensioning symbol relative to
dimension figure, vertical to dimension line

1st symbol combination of Symbol (0-89), Underline,
Augxiliary text, Text delimiter (0-9)

2nd symbol combination of Symbol (0-99), Underline,
Augxiliary text, Text delimiter (0-9)

Set diameter symbol or radius symbol for circular arc
dimensioning?

Reference system for circle dimensioning
Dimension type for Circle dimension

Direction of dimensioning (0-1: Parallel to lines, 2-5:
Axially parallel)

Position of angular dimension between or outside the
selected legs
=} Allow Z-dimensioning for correction

Drawing > Annotations > Dimensioning, 2-D

Some settings can be selected via activation or deactivation of a checkbox. In this example the user has activated

the setting of a symbol (e.g. a diameter symbol) for circular arc dimensions.

Referenced entries

rware und Systeme\HiCAD 2014\HiCAl

File Edit View Extras 15D
08 @

User |Administrator )

4 |qHicaD

[ DIN_A3
[ DIN_AdH
RDIN_A4Q
Automatic drawing derivation
Modelling
Steel Engineering
Metal Engineering
Plant Engineering
Sheet Metal
Assembling simulation
=1 Analysis
Interfaces
PDM
Compatibility
Svstem settinas

Description

52 Figure name

=2 Frame width

== Frame height

=2 Horizontal distance of insertion point to centre
‘=2 Vertical distance of insertion point to centre
== X-minimum of locked area

&2 Y-minimum of locked area

&2 ¥-maximum of locked area

=2 Y-maximum of locked area

Value  Comment
DINAZ  must be located as file in HICAD path C:

584 Dimensions of usable area
410 Dimensions of usable area

0

2163

3968 Title block, tables, comments
0 Title block, tables, comments
584 Title block, tables, comments

55.25 Title block, tables, comments

Drawing > Drawing frames > DIN_A2

In the tree structure, derived data records are marked with the ) symbol. The referenced entry in the right window
is marked with the &= symbol. If you change a referenced value, the referencing will be removed, and the changing
of the value will have no further effects any more.
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Multiple value selection

|1 ISD Configuration Edi == | x
File Edit View BEdras ISD
rd 5] @ User |Administrator ﬂ
4 LhHI(AD il Description Value Comment
4 [2 Active configuration (Base configuration) Show system axes Create system axis annotations in views of the type
= Drawing o Annotate bores Create tags for bores in views of the type
utomatic drawing derivation 5 . S
Drawi Annotate main parts Annotate main parts in views of the type
rawing
N = 1 —

Drawing frames Annotate boltings - - . of the type

Annotations Annotate Standard Parts — — fts in views of the type

Development 3 Annotate sub-parts iews of the type

Type of use assignment Annotate weld seams From front views of type
= Type of use-dependent Left
4 [ Template Right

Drawing frames Back

Annotation Bottom
View group (3-D) | AXO landscape

V!ews AXO portrait
View type assignment, Parts

Sectional view left
View type assignment, General

Sectional view right

[=] View type assignment, Part environment
[ Set of dimensioning rules

it Lok ][ concel |

[ DEFAULT(FLACHSTAHL)

[ DEFAULT(HOHLPROFILE)

[ DEFAULT(I_PROFILE)

[ DEFAULT(PROFILE)

[ DEFAULT(STAHLROHRE)

[ ASSEMBLY_BEAM

[ ASSEMBLY_COLUMMN o

Automatic drawing derivation > Type of use-dependent » Template > View type assignment, General

Some parameters allow a multiple value selection. Click the J icon and select a combination of values from the
displayed list. Click OK to close the list. In the above example the position of an annotation tag for a bore is spe-
cified via a multiple selection.

Collection

3 18D Configuration i =il x
File Edit View Extras ISD
PR~ @ User [Administrator (]

4[] Active configuration (Base configuration) Description Value Comment

INIng W List of Excel report templates Collection @
utomatic drawing derivation

& Modelling

Metal Engineering

Enter the strings in the cellection (one per ling):
SecureFinCalculation_detailed xdtx|

lant Engineering
heet Metal
ssembling simulation

nalysis

=] Interfaces
DM
ompatibility
= System settings
= Line style definition
Processing plane

m

Start configuration

Directories
Load/Save
Data backup

dentification LA

Referencing
Annctations

Calculations
Radial pin calculation

Cylindrical pin calculation
[=] Graphics -

System settings > Calculations > Cylindrical pin calculation

If you are asked for a Collection you can select a template file. Click the J icon and edit the template files in the
displayed list.

To create your own template files, just copy one of the templates supplied by the ISD and adjust it according to your
individual needs. Save the templates to the HiCAD directory templates/... to enable them to be displayed in the Con-
figuration Editor.
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HICAD

IDs

‘ 15D Configuration Editor - HiCAD [C:\ProgramData\ISD Software und Systeme\HiCAD 2013\HiCAD.cfgdb] - |EI|1|
File Edit View Extras ISD
7 = User Administrator - B
= =
= -]_'|HiCAD 1= Description Value Comment
B [ Active configuration (Base configuration) Row ID CatEditor 243700031
3 Analysis Table ID CatEditor 243732027
Assembling Simulation o
Compatibility Row ID CatEditor 243700027
Drawing Table ID CatEditor 243732027
Automatic drawing derivation Row ID CatEditor 243700029
Interfaces Table ID CatEditor 243732027
=& M_EI‘B' Engineering Row ID CatEditor 243700032
= Foil
o Table ID CatEditor 243732027
B [ sealant
=] Material Row ID CatEditor 243700023
& Drawing Table ID CatEditor 243732027
DM _ Row ID CatEditor 243700030
Plant Engineering Table ID CatEditor 243732027

| =

= steel Engineering

il

These are values that refer to other HiICAD files, e.g. tables in the HICAD catalogues.

In the above example the values (IDs) refer to the table Factory standards > User-defined materials > Civil Engin-

eering > Civil Engineering materials in the Catalogue Editor. This table has the 1D 243732027.

In the Configuration Editor the ID entries in the rows determine the selection for the Sealing function. You can
select between the Type (Own production or Available on site), and the Material (Foil, Acrylic, Silicon, Sealing cord).

243700039 > Foil, Available on site
243700038 > Foil, Own production

243700031 > Acrylic, Available on site
243700032 > Acrylic, Own production
243700029 > Silicon, Available on site
243700030 > Silicon, Own production

243700027 > Sealing cord, Available on site
243700028 > Sealing cord, Own production
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Add new data record entry

E 15D Cenfiguration Editor - HICAD 21.0.0.129 [C\ProgramData\ISD Software u.nd Systeme\HICAD 2016\HiCAD.cfgdb] |!:' E] | 2 |
File Edit View Extras ISD
g 2 23§z @ User |Administrator m
4 [HiCAD Usage Part type Usage-dependent setting
4[] Active configuration (Base configuration) Metal Engineering -
ﬁi’aw'”g SRR Contact profile Al MC_STRIP
4 =] Aut it it
e Cover bar Al MC_COVERBAR
4 [ Production drawing .
3 Drawi Facade base point All MC_BRACKET
=2z Urawin
. o Isolator All MC_ISOLATOR
Drawing frames i
[l [ Annotations Seal : All MC_GASKET
[ Development Support profile Al MC_PROFILE
Usage assignment Railing

[ Usage-dependent

B- T ——
.5 1SD Configuration Editor - HICAD 21.0.0.129 [C:\P... |
e

L [= Mounting drawing
| [ Modelling Group t
[ Steel Engineering
[ Metal Engineering

[= Plant Engineering |

My settings] I

| [ Sheet Metal !
S : [
| &) Assem.bllng simulation Rod Al DEFAULT
[ & Analysis Skirting board Al STRINGER I
Interfaces = -
eel Engineerin
= POM Steel Eng g I
[ Compatibility Column assembly All ASSEMBLY_COLUMN |
| System settings Columns All COLUMN
[l ) Configurations Cross-bracing All CROS5_BRACING
[ Frame All FRAME
Girder Round steel BEAM(ROUMND)
Girder Steel pipes BEAM(ROUND)
| Girder All BEAM -
|
Automatic drawing derivation > Production drawing > Usage assignment

In some areas you have the options to add new data record entries, or new groups with data record entries. To do
this, click the New group button, enter a name and click OK. The group will then be added and an empty data
record entry will be shown. When you now click on the input fields, you can compose the data record entry from the
values in the displayed selection boxes.
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1SD Configuration Editor - HICAD 21.0.0.129 [C:\ProgramData\ISD Software £ e |
File Edit View Extras ISD
Q @ User |Administrator ﬂ
4 aniCAD Usage Part type Usage-dependent setting
4 [ Active configuration (Base configuration) | 1T i AT -
= Drawing Knee rail Al STRINGER
4 [ Automatic drawing derivation Mullion All POST
4 [ Production drawing Railing All RAILING
[ Drawing Railing segment All RAILINGSEGMENT
Drawing frames Rod All DEFAULT
Annotations Skirting board All STRINGER
Developrr!ent General "
Usage assignment Al ASSEMBLY_COLUMN
- M US:IQE*:EthdEHt Catalogue =| COLUMN
D SIS Columns CROSS_BRACING
Madelling Civil Enginegring » General > Column FRAME
Steel Engineering Girder
Metal Engineering Civil Enginzering » General » Girder BEAM(ROUND)
Contact profile BEAM(ROUMD)
Plant Engineering ey pPMm‘E nering » Elzmens » Contact profis BEAM
Sheet Metal Cover bar
Assembling simulation Civil Enginzering > Metal Enginsering » Elements > Cover bar ASSEMBLY_BEAM |
Analysis Seal DEFAULT(FLACHSTAHL) L
nterfaces IE'““ '5'”:‘ "Qf’_l"‘m”'gm"‘f S San DEFAULT(HOHLPROFILE)
nserted profile
PDM Civil Eﬂg\ineeaﬂg » Metal Enginsering » Elements » Inserted profile DEFAULT(I_PROFILE)
Compatibility Isolator i DEFAULT(PROFILE)
3 Systern settings ol Engineeting) = HMem| Engureertng > Sements = Fioior DEFAULT(STAHLROHRE)
= i Support profile
EE) Configurations Civi Enginesring » Metal Engineering > Elsments » Sugpart profile
Connector DEFALULT
Civil Enginsering » Metal Engineering » Elements > Connectar
Fixing bracket =
M -
[ MNew ] [ Delete ] [ MNew group ]
Automatic drawing derivation > Production drawing > Usage assignment
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Permissions (CM)

Permissions in the Configuration Editor basically function in the same way as the Windows file system permissions.
Atypical use case is the granting or withdrawing of the permission Change property value - either for all values (via
the context menu of the configuration) or for a sub-tree within the configuration structure, including all values imme-
diately below (via the context menu of the uppermost item of the sub-tree).

Permissions can be assigned in a User-based or Group-based way. By default, each User (except for the Admin-
istrator) belongs to the Group Everyone. If in the Group Everyone the permission Change property value is with-
drawn, “normal” Users do no longer have the rights to change any values. Changed values in HiICAD dialogues, too,
will then no longer apply if they are stored in the configuration management. It is then possible to re-assign per-
missions, e.g. for a particular value or a sub-tree within the configuration structure, to individual Users. Also, Users
can be assigned to other Groups who have different permissions. If a User has no write permissions for a value, this

will be indicated (in an activated User profile) by the % icon.

Select Edit > Permissions. The Permissions... dialogue window will be displayed. In the caption of the dialogue you
will also see the name of the currently selected item in the configuration structure (in the example below this is the
item “Drawing”).

Example

Desigrer A User

Everyons Group

Permissons for: Everyons
P = I
| Change property vakes
[T Activate configuration
I Derive configuration
[ Rename configuration
| Ceelete configuration
™ Derive structurs
™ Delete derived structure
™ Rename derived struchure

=l

11111111115

" Change desived texts
™ Changs permissions

T

Select the User whose permissions you want to change. Then, specify via the Accept and Deny checkboxes, which
permissions are to be granted to the User. Click the Apply button to apply the current settings without closing the
dialogue window. Select OK to apply the current settings and close the window.

@ Please note:

The granted permissions depend, in addition to the selected item in the structure, on the currently active/selected
configuration. Forexample, it is possible to grant permissions starting from a specific configuration derivation level.
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ICAD
Use Settings in HICAD (CM)

All changes made in the Configuration Editor will take effect after a restart of HiCAD. Certain settings, such as pre-

3N
settings for 2-D dimensioning, can be used in HICAD immediately after selecting the Reload I Ifunction (2-D

Dimensioning + Text > Edit> 7 ).

Use the Load parameters = & function (3-D Dimensioning + Text Tools > Dimensioning > Tools ™ ) to take

over the settings of the BEM3DPAR.DAT file.
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Scenarios (CM)

Below you will find some possible scenarios when using the Configuration Management:

How do | create a user-specific configuration if a use a standalone installation?

How do | create a user-specific configuration if | work within a network?

How do | switch between different configurations?

How do [, as an administrator, assign different rights and settings to various users?

How do | transfer the settings of a user to the administrator profile?

| am already a HiCAD user. What effect will an update have on my configuration settings?

How do | transfer settings from HICAD 2014 or 2015 to the Configuration database after installing HiICAD 2016
(new installation)?

What needs to be done in case of an update from a version older than HiICAD 2011 to HiCAD 20137

Why are suddenly new users added to the configuration management of the configuration database, and how
do | prevent individual users from changing their settings?

How can | combine locally saved configuration databases with different settings for individual users into one,
central database without losing the settings for the individual users?

Which settings have priority if administrator settings are different from user settings?
How do | achieve for several workstations that the administrator profile applies to all users?

Which options for the changing of settings in the ConfigDB are available in the template files (.csv)?
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How do | create a user-specific configuration if a use a standalone installation? (CM)

In this case you are “your own administrator”, so to speak. If you want to change any settings, start the con-
figuration Editor and change the administrator profile.

! . Important:
Settings which are saved via HiCAD, e.g. 3-D dimensioning settings, will be saved to the profile of the User who is
currently logged onto the operating system, overriding the settings in the administrator profile. If any values are not
available in HICAD as expected, please check if there are user-specific settings for these values.
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How do | create a user-specific configuration if | work within a network? (CM)

Start the Configuration Editor as Administrator (right-click icon and select Run as administrator) and derive a new
configuration. In the User Management, assign the corresponding configuration to the desired User profile. You

can also assign the configuration to the main Group of the User. In this way you ensure that all Users of the same
main Group will use this configuration.

Switch to the User profile and edit the required settings.

If no derived configuration is required, you can also simply edit the settings after activation of the User profile in the
base configuration.
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How do | switch between different configurations? (CM)

To switch between configurations, select Edit > Activate configuration on the menu bar.

General information on how to activate configurations can be found in the topic User Management.

@ Please note:

m The permissions assigned here apply globally, i.e. to all Users of the Group.

= Select Edit > Permissions to assign permissions to sub-trees of the configuration. You can then define per-
missions for Users and Groups.

m Use the User Management option to activate configurations for several Users or Groups. Assign the desired
configuration to the Users or Groups.
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How do |, as an administrator, assign different rights and settings to various users?
(CM)

Start the Configuration Editor as Administrator (right-click icon and select Run as administrator).

Use the Permission function to assign rights.

Permissions in the Configuration Editor basically function in the same way as the Windows file system permissions.
A typical use case is the granting or withdrawing of the permission Change property value - either for all values (via
the context menu of the configuration) or for a sub-tree within the configuration structure, including all values imme-
diately below (via the context menu of the uppermost item of the sub-tree). Permissions can be assigned in a User-

based or Group-based way.
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HICAD

How do | transfer the settings of a user to the administrator profile? (CM)

Start the Configuration Editor as Administrator (right-click icon and select Run as administrator) .

Select the User Administrator.

User Administrator

vmj

Click the icon on the right. The User Management dialogue window will be displayed. In the dialogue, mark the user

whose values you want to apply.

x|
| Settings | User | Groups |
Mame | Active configuration | Group assignment I | [ Add ]
Administrator [ Same as main groupv] Administrators
User 003 [Sameas main grnupv] Designers D, Designers E [ Rename ]
Same as main group~ RIS AV [ Delete ]
[ Group assignment ]
[ Adopt values ]
[ Delete values ]

Click the Adopt values button to transfer the values of the marked user into the active administrator profile.

Performance - Features - Scenarios

37/48



L
H m Scenarios (CM)

| am already a HICAD user. What effect will an update have on my configuration set-
tings? (CM)

When performing an update from HiCAD 2014 or HiCAD 2015, your settings from the existing configuration file
HICAD.CFGDB of your previous HIiCAD version will be transferred to the Configuration Management of HiCAD
2015, namely into the Administrator profile.

When the update is performed, only the values predefined by the ISD, i.e. the “factory settings”, will be changed.
All other (administrator or user) settings will be preserved.

If you use a central configuration database on a server, it will be automatically detected by the update program by
means of the corresponding Registry entry and will be updated. For an update of several workstations, one single

update will be sufficient; a multiple update will, however, not do any harm either (as an already updated setting will
not be updated again).
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How do | transfer settings from HiCAD 2012 or 2014 to the Configuration Database
after installing HICAD 2014 (new installation)? (CM)

If you perform a (new) installation of HICAD 2016, the settings predefined by the ISD will be initially used in the
Administrator profile of the Configuration Management. If you want to transfer your individual settings in the file
HICAD.CFGDB from HiCAD 2014 or HICAD 2015 to the Configuration Management of HiCAD 2016, use the pro-
gram CfgDbTool.exe in the HICAD EXE sub-directory for this.

Furthermore, you are enabled to transfer settings from old DAT and XML files which are now managed in the Con-
figuration Editor, to the configuration database of Version 2016.

Proceed as follows:
1. Start the CfgDbTool.exe program in the HICAD EXE sub-directory.

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous configuration file (.CFDB) to
the configuration file of Version 2016.

_, CfgDbTaal [ o e ]
I -
Update | Migrate

Installed database C:\hicad\Configuration\HiCAD.cfgdb E]

Update source  D:thicad\Configuration\HiCAD.cfgdb E]

Update target C:\hicad\Configuration'\HiCAD.cfgdb E]
N |

2. Select the directories.

Update tab

Installed The configuration database to be updated, i.e. (the previous configuration database of HiCAD).
database

Update The configuration database of the new version; the configuration database with the current ISD
source settings can be found in the folder: [HICAD installation directory\Configuration.

Update The result of the update. If you enter the same file here as in the Installed database, a backup of
target the previous configuration database will be created. You cannot enter the same database here

that you entered in the Update source field.

3. Click the Update button to start the process.

Use the Migrate tab to transfer your individual settings from old DAT and XML files which are now managed in the
Configuration Editor, to the configuration database of the version 2015.

The setting files with their adjustments need to be copied to the HICAD SYS subdirectory of the new HIiCAD version
for this purpose.

1. Start the CfgDbTool.exe program in the HICAD EXE sub-directory and activate the Migrate tab.
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CfgDbToal a=le
Migrate

Base folder CAHICAD

Target database Chhicad\Configuration\HICAD. cfgdb E] |

Parameter files must be available in sub folders with the same names like in a
HICAD installation (e.g. sys folder) and under their criginal names.

2. Select the directories.

Migrate tab

Base Here you enter the directory where your old DAT and XML files etc. are located. Please make

folder sure that the old files have the same name and are located in the same directory structure asina
HiCAD standard installation.

Target Here you specify the database to which the data are to be transferred.

database

3. Click the Migrate button to start the process.
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What needs to be done in case of an update from a version older than HiCAD 2011 to
HIiCAD 2013 (or higher)? (CM)

The new Configuration Management has been introduced with HICAD 2011. Therefore you need to perform a new
installation for HICAD 2013 (or higher).

Since the Configuration management has not been supported in versions older than HICAD 2011, a manual transfer
of your individual settings in the aforementioned DAT files to the Configuration Management, via the settings on the
Migrate tab of the program CfgDbTool.exe.

The PDF file Schlusselnamen.PDF shows you where the settings from the old DAT files can now be found in the Con-
figuration Editor.
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Why are suddenly new users added to the configuration management of the con-
figuration database, and how do | prevent individual users from changing their set-
tings? (CM)

If, for example, a user saves the 3-D dimensioning settings via HICAD, the corresponding user name will be auto-
matically created in the User Management of the configuration database; the new User will be assigned to the user
Group Everyone by default.

If you (as Administrator) want to prevent a (new) User from saving his/her individual settings, assign only read per-
mission to the Group Everyone. When the user now tries to save the settings via HICAD, a new User will still be cre-
ated in the User Management, but the user-specific settings themselves will not be saved. Instead, the
configuration defined by the Administrator continues to apply.
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How can | combine locally saved configuration databases with different settings for
individual users into one, central database without losing the settings for the indi-

vidual users? (CM)

Copy the configuration database of a computer to the unlocked server directory. Then, export the active con-
figuration on the other computers and import them to the central database again. Assign, via the User Man-

agement, to each User the corresponding configuration.
On the individual workstations, adjust the Registry entry for the storage location of the database.

Start the Configuration Editor as Administrator (right-click icon and select Run as administrator) .
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Which settings have priority if administrator settings are different from user settings?
(CM)

User-specific settings override Administrator settings. Settings in derived configurations override settings in the
superordinate configuration.

Only individual values will be “overridden”: If, for example, an isolated setting contains a User value, this value will
apply to the User. All other settings which have not been changed by the User will be read from the Administrator
profile. The same principle applies to settings in derived configurations: If a setting in a derived configuration con-
tains neither User values nor Administrator values, the superordinate configuration will be checked etc.
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How do | achieve for several workstations that the administrator profile applies to all
users? (CM)

If the Database is located on the server, nothing more needs to be done. To prevent the settings from being over-
ridden by user-specific settings that might exist, all User values should be deleted (select the corresponding User in
the User Management and select Delete values). The User Management will only be active if you started the Con-
figuration Editor as Administrator.

In case of a local configuration database, use the Configuration Editor to export the settings on the configured com-
puter (with Administrator profile). In any case it makes sense to remove all user-specific settings that might still
exist.

On all other computers, select File > Import to read in the exported XML file. All user-defined settings that might
still exist should be removed from all computers.
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Which options for the changing of settings in the ConfigDB are available in the tem-
plate files (.csv)? (CM)

Extensive information on this topic can be found in the document "Working with User-Defined Configuration Tem-
plates" in our Wiki, at Product know-how > Whitepaper.

46/ 48 ISD Group - HiCAD Configuration Management



HIGAD

Performance - Features - Scenarios 47148



I1SD Software und Systeme GmbH

Hauert 4

44227 Dortmund

Germany

Tel. +49-(0)231-9793-0
Fax +49-(0)231-9793-101
info@isdgroup.de

1SD Berlin

Paradiesstrafie 208a
12526 Berlin

Germany

Tel. +49-(0)30-634178-0
Fax +49-(0)30-634178-10
berlin@isdgroup.de

I1SD Hamburg
StrawinskystraBe 2

25337 Elmshorn

Germany

Tel. +49-(0)4121-740980
Fax +49-(0)4121-4613261
hamburg@isdgroup.de

1SD Hannover

Hamburger Allee 24

30161 Hanover

Germany

Tel. +49-(0)511-616803-40
Fax +49-(0)511-616803-41
hannover@isdgroup.de

ISD Niirnberg
Nordostpark 7

90411 Nuremberg
Germany

Tel. +49-(0)911-95173-0
Fax +49-(0)911-95173-10
nuernberg@isdgroup.de

1SD Ulm

WilhelmstraBe 25

89073 Ulm

Germany

Tel. +49-(0)731-96855-0
Fax +49-(0)731-96855-10
ulm@isdgroup.de

ISD Austria GmbH
HafenstraBe 47-51

4020 Linz

Austria

Tel. +43-(0)732-9015-1800
Fax +43-(0)732-9015-1829
info@isdgroup.at

ISD Benelux b.v.

Het Zuiderkruis 33

5215 MV ‘s-Hertogenbosch
The Netherlands

Tel. +31-(0)73-61538-88
Fax +31-(0)73-61538-99
info@isdgroup.nl

ISD Benelux b.v.

Dokter van Deenweg 13
8025 BP Zwolle

The Netherlands

Tel. +31-(0)73-6153-888
Fax +31-(0)73-6153-899
info@isdgroup.nl

ISD Schweiz AG
Rosenweg 2

4500 Solothurn
Switzerland

Tel. +41-(0)32-62413-40
Fax +41-(0)32-62413-42
info@isdgroup.ch

www.isdgroup.com




	Configuration Management (CM)
	Range of features

	Transfer of DAT Files to the Configuration Editor (CM)
	User Interface (CM)
	Menu Bar (CM)
	File (CM)
	Export and import of setting values

	Edit (CM)
	Derive Configuration (CM)
	Derive Structure (CM)

	View (CM)
	Update
	Display key names

	Extras (CM)
	Language
	Database directory


	Toolbar (CM)
	Search Function (CM)
	Search for data records

	User (CM)
	User Management (CM)
	Settings
	User
	Groups

	Configuration Structure (CM)
	Data Record (CM)
	Change a value in an input field
	Select a value from a listbox
	Take value from catalogue
	Select a value by activating/deactivating of a checkbox
	Referenced entries
	Multiple value selection
	Collection
	IDs
	Add new data record entry

	Permissions (CM)
	Use Settings in HiCAD (CM)

	Scenarios (CM)
	How do I create a user-specific configuration if a use a standalone installat...
	How do I create a user-specific configuration if I work within a network? (CM)
	How do I switch between different configurations? (CM)
	How do I, as an administrator, assign different rights and settings to variou...
	How do I transfer the settings of a user to the administrator profile? (CM)
	I am already a HiCAD user. What effect will an update have on my configuratio...
	How do I transfer settings from HiCAD 2012 or 2014 to the Configuration Datab...
	What needs to be done in case of an update from a version older than HiCAD 20...
	Why are suddenly new users added to the configuration management of the confi...
	How can I combine locally saved configuration databases with different settin...
	Which settings have priority if administrator settings are different from use...
	How do I achieve for several workstations that the administrator profile appl...
	Which options for the changing of settings in the ConfigDB are available in t...


